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Introduction

This document contains a compilation of the Release Notes information for all previous
MYOB EXO Business releases from 8.0.0.0 onwards. Information for each release
includes, where appropriate:

e New Features, which describes all new features introduced in the release.

e Resolved Issues, which describe all issues that were addressed by the release.

The New Profile Settings section at the end of this document details any new profile
settings that were introduced in each release.

Note: For details of the most recent release, see the MYOB EXO Business Release
Notes document.

MYOB EXO Business 8.x Version History Page 1 of 300
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EXO Business 8.7

New Features

Changes to Supported Platforms

Office 2013 Support

MYOB EXO Business now supports use with Microsoft Office 2013, including Outlook
2013. 64-bit and 32-bit editions are supported.

This feature was introduced in MYOB EXO Business 8.6 Service Pack 2.

Changes to Job Costing

Support for Perpetual Inventory in Job Costing

In previous versions, perpetual inventory integration was not recommended and not
officially supported in EXO Job Costing. This release includes process changes that
allow EXO Job Costing to fully support a perpetual inventory system.

Note: When EXO Job Costing is installed, the “Stock” option on the Post Ledgers

to GL window now becomes “Stock and Work in Progress”.

Work In Progress Changes

A new Work in Progress control account has been added to the General Ledger
Control Accounts. The new account can be configured in the EXO Business
Configurator at Business Essentials > GL Control Accounts > Custom tab. By default
the Work in Progress account is set to the Stock on Hand Account; you may need to
edit the chart of accounts to add a Work in Progress account to set the new control
account to.

Note: If the Work in Progress control account remains set to the Stock on Hand

account, the system will behave as it did in previous versions.

MYOB EXO Business 8.x Version History Page 2 of 300
Copyright 2014 MYOB Technology Pty Ltd.



EXO Business 8.7

Any Stock Location can now be flagged as a Work in Progress (WIP) location, by ticking
the new Job Costing Work in Progress Location flag on the Stock Locations setup
screen:

= MYOB EXO Configurator - Demo Mode o = E

IA Creditors 35 Code: WIP Name: WIP
;--Credlmr Account Groups Details
i Lo Alternate Creditor Account Groups
4 Stock
Location No: 5 Active
- Stock Groups =
- Alternate Stock Groups Code: WIP
-| Stock Locations |
: WIP
Stock Price Groups Name
- Stock Unit Definitions Address : P
- Price Names
- Warranty e
4 Debtors
. Debtor Account Groups [FExcude from Free Stock
- Alternate Debtor Account Groups []Exclude from Sales
'iDEbmr Price Policy Groups Exdlude from Valuation
4 5,
?-EI‘:arketng [#] Job Costing Work in Progress Location
4 Inwar
. e —— —

The ability to specify locations as WIP locations allows restrictions to be placed on
various location selection fields in the EXO Business system:

e When selecting a Stock Location for WIP, only locations that are marked as WIP
locations can be selected.

e When selecting a location elsewhere in the system, in most cases Stock
Locations that are marked as WIP locations are excluded from the choices. (On
some screens, e.g. Stock transactions, any location can be selected.)

e The Default job work in progress stock location profile setting only displays
Stock Locations that are marked as WIP locations.

e All other profile settings that set a default location only display Stock Locations
that are not marked as WIP locations.

Note: Average costs are now affected by Stock on Hand levels only, not Work in

Progress levels.

Negative stock warnings appear as normal when moving stock into Work in Progress
from Stock on Hand, but no longer apply when moving stock out of WIP.

Note: At this time, the Recalculate Weighted Average utility can only be run in
EXO Business 8.7 if EXO Job Costing is not installed, due to the
complications of working through the transition to the new stock
movement handling with WIP. Going forward, it will only be possible to

execute the recalculation from the point of transition onwards, based on a
snapshot valuation taken as part of the transition process. There is no
effect on users without EXO Job Costing users (although internally the
recalculation process is now converted to a viewable stored procedure in
the database).

The Only Move stock when invoicing and Stock on jobs is moved out of stock on hand
settings have been removed from the Business Essentials > EXO Job Costing section of
EXO Config, as they no longer apply.



EXO Business 8.7

The Ledger Reconciliation widget on the EXO Accountant’s Assistant now includes a
WIP Control section when EXO Job Costing is installed:

Las!

WIP CONTROL VARIANCE

Tolersnce: 55

t Calculated: 14.11.2013 3:30:21PM

[T} MYOB EXQ Accountant's Assistant - Demo Mode o B =
Financial Period: 0. November 2013 -
i File Utilities Setup Help
A
[ 3
b -
Business. Financial Systems Education
Checkiists Review Integrity Centre
Layouts: Defauit - d H+ @-
Systems Integrity x
= @ Utilities
& Tedger Refresh
© Data Verification
© Tax Rate Exceptions
$33,575 ) $33,575
DEBTCRS CONTROL \VARIANCE DEBTORS LEDGER
Tolersnce: 55
$57,242 $57,242
CREDITORS CONTROL VARIANCE CREDITORS LEDGER
Tolerance:
$308,518 $308,518
STOCK CONTROL. \VARIANCE STOCK LEDGER
Tolersnce: 55
$6,012 $6,012

WIP LEDGER

[Demo

| Exoadmin

Motopartz.co.nz

New Recoverable Flag for Stock Items

When EXO Job Costing is installed, a new Recoverable flag is available on the Stock

Item Details window:

|21 Stock frem Details
i File Utilities Mavigate Help
e Save & Exit

g New | g Save

Stock Code: RETENTION

X Cancel

AT AN R

Description: RETENTION

Details 1 | Details 2 | Extra Fields | Transactions | Orders | Works Orders | Web

(oo
@

J

Motes | History Notes | Documents | Analysis

Stock code:  RETENTION
Groups

Stock group (Fine): MISC ITEMS

Stock Group {Coarse): | NO GROUP SELECTED
Classification: NORMAL
Price group: MISC

Other
Main supplier :

Unitf Pack:
Link stockcode:

Serial no. tracked: Mot Serialised

Description: |[RETENTION

Cost Prices Sell Prices
lz‘ Supplier (MZD): $0.00 1. Internet:
=] Last £0.00 2. Retai:
lz‘ Average: £0.00 3. Trade:
[«]  stendard: $0.00 4. UK:

5. Us:
Flags

E] Active 6. Fiji:

[+] e 7. Australia:
8. Singapore:

(No)

¥ | LIscouUntanie

[ restricted Goods 9. ComputedSellPrice:

11. Price 11:
Item expires

£0.00
£0.00
50.00
£0.00
£0.00
50.00
£0.00
£0.00
$0.00
50.00

Yt Back Order Incomina

This flag is only enabled if the item is a lookup item. When ticked, it designates the
stock item as a recoverable expense for Job Costing, meaning that transactions relating
to it will generate General Ledger WIP journals. Non-recoverable lookup items do not

affect the General Ledger.



EXO Business 8.7

By default, the flag is ticked for all stock items, except for linked stockcodes.

New Jobs Tab on Stock Items

A new Jobs tab is available on the Stock Item Details window when EXO Job Costing is
installed. This tab displays any in progress jobs that are using the stock item:

|21/ Stock Item Details = ol )
i File Utilities Navigate Help )
i3 New | bl Save LA Save & Exit Cancel | di - | H 4 F H |2

Stock Code: MOTOILO1 Description: MOTOR OIL

Details 1 | Details 2 | Extra Fields | Transactions | Orders | Jobs | Works Orders | Web | Batch Qty | Notes | History Notes | Documents | Analysis

Layouts: Default - H |+ EH-
WIP Stock (Grid)
Grid SQL
Location Job Code Description Qty Unit Cost Line CostiC
1 MOTOR OIL 14 §2.91 $40.74 r
1 MOTOR. QIL 14 £2.91 £40.74 2
WIP 12 MOTOR OIL 1 £2.91 £2.91 2
WIP 5 MOTOR OIL 1 £2.91 £2.91 2
WIP 3 MOTOR OIL 1 £2.91 £2.91 2
WIP [ MOTOR OIL 1 £2.91 $2.91 2|2
WIP 9 MOTOR. QIL 1 £2.91 £2.91 2
33.00 $96.03
e ____-'-\——-_\_—__ ——

The tab consists of a dashboard interface, with two widgets available to display the job
details:

e WIP Stock (Grid) — displays job details on an ExoGrid.
e WIP Stock (Report) — displays job details on a Clarity report.

By default, only the grid version of the WIP Stock widget is displayed on the Jobs tab.
The Clarity report version is available, but must be added to the dashboard using the
Add Widget button on the dashboard (+).

Written Off Lines

When job lines are written off, costs of those lines are now stored in the new
LINECHARGE_WRITEOFF fields in the JOBCOST_HDR and JOB_TRANSACTIONS tables.
This means that lost sales can be now reported on, and WIP write-offs can potentially
be posted to a separate General Ledger account from stock adjustments.

Write-off journals are now recorded differently; a new Non-Stock Write-offs GL
Control Account is available, which is used as follows:

e Written off stock item lines credit Work in Progress and debit Stock
Adjustments.

e Written off lookup item lines credit Work in Progress and debit Non-Stock
Write-offs.

Note: The ability to un-write off lines has been removed in this release, as it

resulted in incorrect journals due to the changes in this release. This
feature may be reactivated in a future release.




EXO Business 8.7

Changes to Progress Billing and Job Invoicing

As of EXO Business 8.7, the progress billing feature is enabled by default (in an upgrade
to 8.7, this feature is turned on). This means that the Billing Schedule tab is now always
visible on all jobs. This tab has been updated to display all invoices relating to the job,
not just progress billing invoices. In an upgrade, the tab is populated for each job with
any existing invoices for that job.

Job Details [E=3) ol =
i File Mavigate Utilities Progress Billings Help (5 ]
Pnew |5 [ Save | (@ SavedBit < Cancel | Pt - | [4 4 b bl | I ProgressBiling - [ Retention Levels J
R 0. CAS =3 Job Progress 0K
Details | Quote/ Budget Purchases | Costs | Invoice | Documents | Analysis | History Notes | Biling Schedule | Activities
Schedule # Description Subtotal  GSTTotsl  Amount Invoice Date  Proforma Invoice Invoice No. Outstanding Alocated Cost

1 Job Inveice - 1007 $52.85 £9.43 £72.29 30.10.2013 1007 $0.00 £0.0]

2 Credit Note - CR1007 (62.86) (9.43)  (72.29) 30.10.2013 CR1007 40,00 £0.01

3 Progress billing schedule £360.00 $54.00  $414.00 30.10.2013 1008 £396.00 £0.01

4 Manual credit note (10.00) (L50)  (1L50) 1009 (8.50) £0.01

5 |schedule 2 £52.85 £.43 £72.29 09.10.2013 1010 £69.15 £0.0|

$412.86  $61.93  $474.79 $456.65 50.0|

Invoices and credit notes can also be entered into the grid manually.

Note: The Billing Schedule tab can now be hidden by entering “B” into the Hide

tabs in Job management screen profile setting.

Crediting Job Invoices

Invoices created from EXO Job Costing cannot be edited; however, they can be
reversed/credited. Credit notes can be created for job invoices by right-clicking on the
on the Billing Schedule tab and selecting Generate Credit Note. Credit notes for job-
related invoices can also be generated from the Transactions tab on the Debtor
Account Details window—when right-clicking on a job invoice, the existing Generate
Credit Note option becomes Generate Credit for Job Invoice. Once generated, credit
notes also appear on the Billing Schedule tab.

Crediting a job invoice completely reverses the transaction, including all stock
movements and progress invoice allocations. Credited invoice lines appear on the
Invoice tab, where they can be cancelled or written off as required. A Select Lines
From Credit Note right-click option on the Billing Schedule tab takes you to the Invoice
tab, filtered to show only the credited lines.

Read-Only Debtor Invoice Window

The Debtor Invoice window now opens in a read-only mode when opened from an
exo:// URL or when opening a Progress Billing Invoice (see page 7).

When in read-only mode, the Debtor Invoice window includes a new Print button in
the toolbar.



EXO Business 8.7

New Send All to Invoice Button

This release adds a Send All to Invoice button to the Timesheets tab of the Job Details

window:
|21 Job Detaits o) |

! File Mavigate Utilities Help (5 ]

Job No: 14 - ASSEMBLE RACE CAR

Show
Ready To Invoice Work in Progress Invoiced Cancelled Written-off Hide Kit Components
Job Mo Job Code Staff Name Code Details Cost Sell Start date
14|14 GREG MANNING LABOLIR. STAMDARD LABOUR. ... £18.00 £45.00 29/05/2013
S—— __R_

Clicking this button sends all lines on this tab to the Invoice tab.

Progress Billing Invoicing

In previous versions, each line of a Billing Schedule could be invoiced individually and
would generate a one-line invoice in EXO Business; this has been extended to now
allow users to create and manage a “proforma invoice” for each line in the Billing
Schedule, which forms the body of the invoice created.

Proforma invoices allow users to record multiple invoice lines against a single Billing
Schedule line, allowing for extensive detail to be recorded and invoiced:

=/ Proferma Invoice - Job Code: 14
i File Utilities Help 5 ]

New. A Save < Cancel | 7] New Account | oy Tax Rates

Account: 23, DANIEL PAYNE Salesperson: 8. EXO BUSINESS ADMIN ACCOUNT GST Induded:

Invoice date: 12.06.2013 [Ehg Customer order no: Age: 0. June 2013 - Campaign Wave:

bomentde:  moemi O meess [ | w1 omonan

Refoence T o
Stock Code Description Qty  @Price Disc(3) Total BatchCode  Options  Analysis Codes Job C
00-00000-00 First Instalment 1 68.14 0.0 68.14

Claangeor  iFlAnGEKIT 1 68.56 0.0 68.56 =

mCAMADJOl ADIJUSTABLE CAM SHAFT 1 194.38 0.0 194.38

Note: Proforma invoices are stored in the tables DR_TRANS_PARK and
DR_INVLINES_PARK. (These tables are also used to store parked
transactions for the EXO POS module.)
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When invoicing a Billing Schedule line, the invoice form is now populated based on the
related proforma invoice line, if it exists. If no proforma lines exist for the schedule, the
invoice is created as normal, i.e. based on a single default general revenue line.

Proforma invoices support both line and header narratives. Header narratives are also
displayed in the Billing Schedule tab of the Job Details window, against the relevant
Billing Schedule line:

|21 Job Details
i File Mavigate Utilities Progress Billings Help

G Print -~ [ 4 b B | FInvoiceBill -

Job No: 14 - ASSEMELE RACE CAR Account: 23, DAMIE

Details | Quote/ Budget | Timesheets | Purchases | Costs | Invoice | Docliments | Analysis | History Motes | Biling Schedule | activities
|

edule # Description Subtotal GST Total Amount Invoice Date  Proforma Invaice
m 1 |First Instalment $97.35 $9.73 £107.08 |06.11.2013
2 Second Instalment 1,394.12 139.41| $1,533.53|06.11.2013
Edit Marrative - (Clear to remowve) $0,00 |06,11,2013

Add a narrative to this line. L 2

These new narratives replace the Notes field that existed previously for Billing
Schedule lines; all notes data is migrated to narratives during the upgrade to 8.x. When
a schedule is invoiced, narratives are copied to the invoice as appropriate.

The Billing Schedule Proforma Invoice form (JobProforma.CLF) has been updated to
display line-level information. The Job Quotation form (JobQuote.clf) has been
updated to use the DR_TRANS_PARK and DR_INVLINES PARK tables where
appropriate. New form profiles are available for Billing Schedule quotes and Proforma
invoices (see page 285).

Note: In previous versions, it was possible to allocate costs to an un-invoiced
Billing Schedule—in this case, the system would delay posting Cost of Sale
until the invoice was generated with Work in Progress. This workflow has
been changed: Billing Schedules must be invoiced before any allocations
can be made, and the appropriate journal for the allocation occurs
immediately.

Billing Schedule Stock Codes

Billing schedules now always default to the stock code “@” —the Code field has been
removed from the Billing Schedule window when creating a billing schedule, and the
Code column has been removed from the Billing Schedule tab.

Note: See “GL Codes on Debtor Invoices” on page 17 for more information on the

“@” stock code.
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The profile setting SQL statement to refine stock item search for Progress Invoice has
been removed, as it is no longer relevant.

Converting Quotes to Invoices

When selecting the Convert Quote to Invoice option on the Quote tab toolbar, the
system now displays warning messages if any of the lines to be invoiced contain
serialised or batch-tracked stock items:

-

Convert Quote to Invoice @

5% Cannot convert this quote directly to invoice as it has serialised stock
' iterns.
~ Toinvoice this quote, use the 'Convert Quote Lines to Actuals' option,
and then assign serial numbers

Freight on Job Invoices

Users are no longer automatically prompted to add freight to invoices created from
EXO Job Costing, regardless of whether or not freight is automatically added to
invoices elsewhere in the EXO Business system.

Sub Job Roll-up

It is now possible to display the sub jobs of master jobs on job grids. A new Include Sub
Job Lines option is available on the Quote, Timesheets, Costs and Invoice tabs of the
Job Details window when viewing a master job—when this option is ticked, the lines of
all of the job’s sub jobs are displayed:

| Job Details [E=5|E=R
i File Mavigate Utilities Invoice Help Q
| =8 o Save | A Save& Bt < Cancel |aPrint - | M 4 b M |13 CreateAsset - & 4 | | [E InvoiceJob = |

OLLAND MOTORS FLEET SERVICH

Details | Quote/ Budget | Timesheets | Purchases | Costs | Invoice | Documents | Analysis |H\story Notes |Sub Jobs IB\\Ilng Schedule I Ach\dmesl

Show
Ready ToInvoice [ |Workin Progress [ tnvoiced [ cancelled [ wrritten-off [T Hide Kit Components I Include Sub Job L\nasl Filter f[

7 Job Code Code Description Quantity Cost  Total cost Sell Line Total Price Disc (%) Mark up Status Invoiced Sta +
1 s _MIRSRVC  MAJOR SERVICE KIT 1 515009 5000 $269.66 5269.66 00%  79.67% Read... 50.00 28]

D 5 AIRFILO1 OVALCHROME AIR F... 1 $49.99 $49.99 $62.04 $62.04 0.0% 24.11% |Read... $0.00 28f

il 5 MOTOILO1 MOTOR OIL 1 §2.91 §2.91 §4.45 §4.45 0.0% 52.92% |Read... §0.00 | 28/|

[=] 5 NGKSPRK4PK  |NGK EXTEMDED REA... 1 §35.44 £35.44 §53.17 $53.17 0.0% 50.03% |Read... €0.00 | 28/|

D 5 LABOUR STANDARD LABOUR ... 3 §13.00 §54.00 §45.00 §135.00 0.0% 150.00% Read... §0.00 28f

[ ] 5 RADCLNTO1 |RADIATOR COOLANT 1 §7.75 §7.75 §15.00 §15.00 0.0% 93.55% [Read... $0.00 28/| _

i E _MIRSRVC  MAJOR SERVICE KIT 1 $150.09 $0.00  $269.66 $269.66 00%  79.67% Read... $0.00 27,

il 12 AIRFILO1 OVALCHROME AIR F... 1 §49.99 §49.99 §62.04 §62.04 0.0% 24.11% |Read... §0.00 | 27/|

] 12 MOTOILO1 MOTOR. OIL 1 $2.91 §2.91 §4.45 $4.45 0.0% 52.92% |Read... |

D 12 .| §35.44 $35.44 §53.17 $53.17 0.0% 50.03% |Read...

[ £40 00 §135.00 0.0% 150.00% |Read. .,

In addition, the Job Code column on the Quote, Timesheets and Costs tabs is now a
dropdown that allows you to select the master job or any of its sub jobs, allowing users
to quickly switch lines between jobs.
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The addition of these features makes it possible to perform bulk actions on all sub-jobs
of a master job, e.g. converting all quote lines to actuals or invoicing all lines, giving
you more freedom to manage jobs by splitting them into sub-jobs.

When choosing to Invoice Job with Sub Jobs from the Invoice Job dropdown on the
Invoice tab, the generated invoice has the correct Job Code for each sub job on the
invoice lines and the Job Code for the master job on the invoice header. (Previously, all
lines were set to the Job Code of the job that the invoice was generated from).

Note: The existing Allow invoicing of sub jobs from master jobs profile setting

must be ticked to enable the Invoice Job with Sub Jobs option.

A new Check for Alerts option is also available under the Invoice Job dropdown.
Selecting this option checks all lines for errors that would prevent invoicing.

[ InveiceJob  ~ L
[H Invoice Job
| Invoice Job with Sub Jobs

Check for Alerts

A new Allow Invoice via Master Job option is available on the Details tabs of sub jobs.
When this option is ticked, the job can be invoiced from the master job.

|21/ Job Details
i File Mavigate Utilities Help 9

Sub-job Ne: 5 - 10,000kM WARRANTY SERVICE - QBI-098
of Master Job: 4 - PAUL HOLLAND MOTORS FLEET SERVICE

Job details Customer Dates
Code: 5 I [¥] Allow Invoice via Master Job JobMgr: | David Cranston w|  Created: 27.08.2013 %:17PM

Title: 10,000KM WARRANTY SERVICE - QBJ-098 Cust O/N: Quoted: [=] oo:00

Status: [in Progress - Contact: [+ st 11,10.2015 [+] 0200 (2]

Type: 10,000k Service - Site address: Due: 11102013 [+] 1700 [

Line 1: 36 BURLEIGH ST OE— e —]
Cateaory Line 2: MATTLAND Complete: E‘ oo:00 =

E

|21/ Job Details
i File Mavigate Utilities Help @

Job No: 4 - PAUL HOLLAND M

Serial Mo Title
5 12 |PALL HOLLAND MOTORS 10,000KM WARRANTY SERVICE -...
o 12 |PALL HOLLAND MOTORS 10,000KM WARRANTY SERVICE -...
7 12 |PAUL HOLLAND MOTORS 20,000KM WARRANTY SERVICE - ...
3 12 |PAUL HOLLAND MOTORS 20,000KM WARRANTY SERVICE -...
9 12 |PAUL HOLLAND MOTORS 30,000KM WARRANTY SERVICE -...
10 1 12 |PALL HOLLAND MOTORS 30,000KM WARRANTY SERVICE -...
11 1 12 |PALL HOLLAND MOTORS 20,000KM WARRANTY SERVICE -...
12 1 12 |PAUL HOLLAND MOTORS 10,000KM WARRANTY SERVICE - ... =
13 1 12 |PAUL HOLLAND MOTORS 10,000KM WARRANTY SERVICE -...

If this option is unticked for a sub job, it will not be possible to select the job for
invoicing on the Invoicing of Sub Jobs from Master Job window.
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Job Costing Extra Field Events

Event logic has been added to Extra Fields in EXO Job Costing. This functionality, which
was previously available for Sales Orders and Opportunities, allows Extra Fields on job
headers and lines to be populated automatically.

Extra Fields on the job header can be configured to update their values when the
company account number on the job is first specified or when it is changed; similarly,
Extra Fields on job quote lines or job transaction lines (timesheets, costs) can be
configured to update whenever the stock code on the line is specified/changed.
Setting up events on job Extra Fields means that it is possible for the Extra Fields set up
on a company/stock item to flow through to the job.

When setting up Extra Fields in EXO Business Config, if JOB_TRANSACTIONS,
JOBCOST_HDR or JOBCOST_LINES is selected for the Table name, an Events tab
becomes available:

E MYOB EXO Configurator - Demo Mode o [BOER
 File Account Help
i fe. | {3} Company <] Essential [ Admin |8 System |6 Profiles =] Forms & Staff i+ Utilities

4 System | Mew | Edit | [ Save ¢ Cancel | f[j Delete | [ 4 b M |5 AddField <4 Encryption

i~ Display Names
4 EventLog Table: J0B_TRANSACTIONS

-Event Reason Classes
-Event Reasons
i Extra Fields

Details | Events

Event Field Name:  STOCKCODE
Parameters allowed: STOCKCODE,JOBNO,MASTERIOBNO,ACCNO, CURRENT_USER
Event 5QL:

The Event Field Name field displays the field on the Job Details window that will
trigger the Extra Field update. For Extra Fields on the job header, this is ACCNO; for
Extra Fields on job quote and transaction lines, it is STOCKCODE.

The Event SQL field contains the SQL statement that will be used to populate the Extra
Field when the relevant Opportunity field is set or changed. The following parameters
can be used to pass in details:

Job Header Job Quote Line Job Transaction
e :Accno e :Stockcode e :Stockcode
e :Current_User e :Current_User e :Jobno

e :MasterJobno
e :Accno

e :Current_User

Note: Extra Field events override default values—if a default value is specified for

an Extra Field that is populated by events, it will be ignored.
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Extra Fields on the Details Tab

Extra Fields in positions 1 — 5 are now displayed on the Details tab of the Job Details
window:

Job details Customer

Code: 14 Job Mgr: Exo Business Admin Account = Created:  28.06,2013 9:16 AM

Title: ASSEMBLE RACE CAR Cust OMN: Quoted: [=] oooo [+

Status: [1nProgress -] Contact: 46, DANIEL PAYNE [+] stk 21.07.2013 [+] om0 14

Type: [ = -] Site address: Dus: 01.09.2013 [+] 000 |4
Line 1: DANIEL PAYNE T T o

Category: [Cotmerual v] Line 2: 15 NUGENT STREET Complete: E‘ 00:00 =
Line 3: GREY LYNN . . Lat

Account; 23, DANIEL PAYNE e | AUCKAND FollowUp: 28.06.2013 [v] 0318 |2}
Line 5:

Campaign Wave: Line &:

Opportunity:

Extra fields

Branch: |u, AUCKLAND E|| Billing Mode: Chargeup. | | Extrafield 1: 2592.24

A [.we -] Extra field 2: 23.06.2013 B

Entered: [mmmmt v]

Our ref

Job Flags

Extra Fields in position 6 — 24 are displayed on the Extra Fields tab as in previous
versions. When adding a new job, the Extra Fields on the Extra Fields tab can now be
edited before saving the job.

Extra Fields on Direct Time/Material Entry

Any Extra Field defined for the JOB_TRANSACTIONS table will now appear on the
Direct Time Entry and Direct Material Entry windows:

Today's Date: 11.06.2013 Default Date: 11.05.2013

Total Qty. Source Ref Batch Code Gross Margin. .. Analysis Codes Extra Field 1 Extra Field 2

1 24.20%

Default Date: 11.05.2013

GST Mo. Disc (%) Source Ref Batch Code Total Cost Analysis Codes Extra Field 1 Extra Field 2
DR 0.0% £0.00

If event logic has been set up for Extra Fields on the JOB_TRANSACTIONS table (see
page 9), these Extra Fields will auto-populate based on the event logic when displayed
on the Direct Time Entry and Direct Material Entry windows.
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Foreign Currency Debtors

Debtor accounts that use a foreign currency can now be used in EXO Job Costing if the
Allow foreign currency debtors in Job Costing Company-level profile setting is
enabled.

Note: This profile setting existed in previous versions as a hidden setting; it is

now available as an “Occasionally Used” setting.

Changes to the Job Search Tab

The following improvements have been made to the Search tab on the Job
Management screen:

=1/ EX0 Job Costing [r=-|l-o -]
! File Navigate Utilities View Help (5]
i 47 New | =5 L Save | L Save & Exit Cancel | g Print ~ | H 4 b M
Job Ne: 1-REPAIR TRE-754
Search | Job Overview | Resource Planning
Job Flags Job statuses Job types Categories Resources Entered By Job Mar
"] Invaice Read 7] cancelled ["] Repair/maintenance » | (] Commerdal [ Bridget Fairweather [ Bridget Fairweather . | || Bridget Fairweather
[ Active Jobs [ Finished [7] Assembly build @ [ Domestic [ pavid Cranston "] David Cranston [7] David Cranston
[[] Incomplete Jobs [} 1In Progress [ 5,000km Service [ Insurance "] Greg Manning [ Dema Demo
[ Archived Jobs [ New Job [ 10,000km Service [ Warranty [ Hydrolic Lift 01 [ Exo Business Admin H [] Exo Business Admin H
[ Quote (7] 20,000km Service [ Hydrolic Lift 02 [l Greg Manning ["] Greg Manning
[T Scheduled [7] 30,000km Service ["] Malcolm Breen [l Internet Sales "] Internet Sales
[ 40,000km Service ™ [ Tim McIntosh [ Malcolm Breen = | | ] Malcolm Breen 2
Search key: 2
[ Search l [Tl Extensive Search returned: 20
Master Job Code  Job Code Master Job No & JobNo  Status AccNo  Name Our ref Title Branch Catege =
|1 UWNPROGRESS  9|RENTTAROT | REPARTRETS: ___ AUCKLAND IR
3 3 3 3 |SCHEDULED 11 |OWEN DENTON MINOR SERVICE 5V1-525 AUCKLAND | DOMES|
4 11 4 11 |QUOTE 12 |PAUL HOLLAND MOTORS 20,000KM WARRANTY SERVICE - ... |AUCKLAND | COMME|
4 4 4 4 |IN PROGRESS 12 |PAUL HOLLAND MOTORS PAUL HOLLAND MOTORS FLEET 5... |AUCKLAMD  COMME
4 5 4 5 IN PROGRESS 12 |PAUL HOLLAND MOTORS 10,000KM WARRANTY SERVICE - ... |AUCKLAND  COMME
4 6 4 6 |IN PROGRESS 12 |PAUL HOLLAND MOTORS 10,000KM WARRANTY SERVICE - ... |AUCKLAND | COMME|
4 7 4 7 IN PROGRESS 12 |PAUL HOLLAND MOTORS 20,000KM WARRANTY SERVICE - ...|AUCKLAND  COMME
4 3 4 8 |IN PROGRESS 12 |PAUL HOLLAND MOTORS 20,000KM WARRANTY SERVICE - ... |AUCKLAND  COMME
4 9 4 9 |IN PROGRESS 12 |PAUL HOLLAND MOTORS 30,000KM WARRANTY SERVICE - ... |AUCKLAND | COMME|
4 10 4 10 |QUOTE 12 |PAUL HOLLAND MOTORS 30,000KM WARRANTY SERVICE - ... |AUCKLAND  |COMME
4 12 4 12 IN PROGRESS 12 |PAUL HOLLAND MOTORS 10,000KM WARRANTY SERVICE - ... |AUCKLAND  COMME
4 13 4 13 |QUOTE 12 |PAUL HOLLAND MOTORS 10,000KM WARRANTY SERVICE - ... |AUCKLAND  COMME
14 14 14 14 |IN PROGRESS 23 |DANIEL PAYNE ASSEMBLE RACE CAR AUCKLAND  COMME
15 15 15 15 |QUCTE 0| CASH SALES ROADWORTHY TEST AUCKLAND | DOMES
16 16 16 16 |QUOTE 0 | CASH SALES CUT AND POLISH AUCKLAND | COMME
17 17 17 17 |QUOTE 0 |CASH SALES NEW TYRES AUCKLAND  DOMES
18 1 18 |QUCTE 0 |CASH SALES GREASE AND OIL CHANGE AUCKLAND | DOMES
DEMO DEMO 19 19 |NEW JOB 0 | CASH SALES DEMO AUCKLAND | DOMES
MASTER MASTER 20 20 |NEW JOB 2 |ALL CAR PARTS MASTER JOB AUCKLAND  DOMES pu
4 D »

1. The screen now remembers the statuses of the filter panels, so that when they
are turned on or off using the View menu, they will remain on or off when the
screen is closed and re-opened. If all filters are turned off, the filter area now
disappears, giving more screen space for the search results.

2. The search grid now includes columns for master job codes and ID numbers, so
that related sub jobs can be grouped together and jobs can be searched for by
their master job.

3. The search grid now includes a Branch column, so that search results can be
sorted by branch.
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Link between Job Transactions and Stock Transactions

A new STOCK_TRANS_SEQ_IN fields has been added to the JOB_TRANSACTIONS table.
If the job transaction is related to a stock transaction, e.g. a Purchase Order, this field
contains the ID number of the stock transaction. This field can be used in reports to
provide a link between job and stock transactions.

Hiding the Resource Planning Tab

The Resource Planning tab (which displays all resource allocations in the system in the
form of a Gantt chart) can now be removed from the Job Management and Setup Job
Resource Allocation windows by enabling the new Hide Resource Planning Gantt Form
User-level profile setting.

Job Costing Dashboard Tabs

The Analysis tab on the Job Details window in MYOB EXO Job Costing is now a
Dashboard interface, containing the following widgets:

e Job Invoice Summary
e Job Summary

e Job Including Sub-Jobs
e Job Snapshot

e Current Job Alerts

|21/ Job Details = e <

i File Mavigate Utilities Help @
P09 New |ER ] Save | [ Save&Exit 3 Cancel |@Print - | H 4 b H J
Job No: 14 - ASSEMBLE RACE CAR.

Details | Quote/ Budget h Purchases | Costs | Invoice | Documents | Analysis | History Notes | Biling Schedule | Activities
Layouts: Default - | H+ B
Total ({InclGST) Invoiced Invoiced % -
Job Cost Invoice 366814 421836 366814 10000 om0  Guole
Debtor Invoices 366814 421836 65004 O Actusl
Debtor Receipts 6,000 4 B nvoice |
Retentions 5,500 417
50003
4500 7
400047
3500}
3000 4
Description Hours Cost Price  Sell Price Profit  Margin pyses | B8
Cost Tab 566705 366814 199301 3527 20003
Timeshest Tsb 4000 72000 180000 108000 150.00 15003
Total: 40.00 6387.05 546814 01891  -14.39 1 233 ]
Quote 668558 500147 -150411 2384 5
Invoice 566705 366814 199301 3527 Cost Invvnice
Current Job Alerts v X
Description Hours CostPrice SellPrice  Profit  Margin urrent Job Aler
Cost Tab 566705 366814 -199891 -35.27 )
Quoted price exceeded
Timesheet Tab 4000 72000 180000 108000 15000
Total: 4000 6387.05 546814 -91891  -14.39
Quote 668558 500147 159411 2384
Inveiced 566705 366814 199801 3527
Motopartz.co.nz

These widgets are based on Clarity reports, and can be customised to suit your needs.

A second Dashboard tab has been added to the Job Details window. This Dashboard is
blank by default, and can be customised with whatever widgets you require.
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Both new Dashboards accept the following input parameters:

e CurrentlJob No
e Current Master Job No

The Hide tabs in Job management screen profile setting has been updated to allow
the new Dashboard tabs to be hidden if necessary—the Dashboard tab is hidden by
default.

Custom Filters

New custom filtering options are available on the Quote/Budget, Timesheets, Costs
and Invoice tabs of the Job Details window. To create and apply filters, click the new
Filter dropdown button:

=/ Job Details [E=HE=ECx3
i File Mavigate Utilities Quotes Help @
P Mew |5 [l Save | [ Save &Exit 3 Cancel |@Pint - | 4 b M |4 3 |Z3Copy [ 4 5B 3] Convert Quote -~ J

Job Progress OK

Quote/ Budget | Timesheets | Purchases | Costs | Invoice | Analysis | Documents | History Notes | Biling Schedule | Activities

Quote Options : | ¥ DEFAULT OPTION Setup... [ Hide:

Filter 7 [+]
| Job Code Code Description Quantity Copy to GST No. Cost/ Sell Total Markup (%) Status Date =
D 14 ENGINE ENGINE 1N CR $4,172.24 $0.00 $0.00  -100.00% Q 29.05.201
D 14 it e A 1N CR §999.99| $1,394.12 $§1,394.12 39.41% Q 29.05.201

=" - CR $18.54 §29.21 $29.21 57.55% Q| _290oa8

£40.0% £10 0c

Any filters that have already been defined are available in the dropdown. You can also
select None to turn off filtering, or Maintain Filters to create and edit filters on the
Maintain Filters window:

|| Maintain Filters =N =R
! File Help i ]
P New | o Select&Close [of Save ¢ Cancel | ff[J Delete .2 Rename ]

Filter: Mew Filter -

AND  <root=

E] Supplier eguals 3

----- [) LmETOTAL is areater then 100

[ press the button to add & new condition |

Manual filter [

Motopartz.co.nz

To edit an existing filter, select it from the Filter dropdown. To create a new filter, click
New. Filters are edited using the same interface that is currently available when
creating Contact Lists and searching for Debtors in Advanced Search mode. Users can
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create one or more filtering conditions based on the fields for the relevant table
(JOBCOST_HDR, JOBCOST_LINES or JOBCOST_TRANSACTIONS).

Note: Computed fields are not supported in custom filters.

As users add filtering conditions, the resulting query is displayed at the bottom of the
window. Users can tick the Manual filter option to edit this query manually; doing so
disables the filter building controls.

Click Save after editing a filter to save the changes and apply the filter immediately.
The icon on the Filter dropdown changes from red to green to indicate that a filter is
currently applied. You can also apply an existing filter by selecting it from the
dropdown and clicking Select and Close. Filters are saved separately for each tab, e.g.
filters set up on the Costs tab will not be available on any other tabs.

Grid Column Extra Fields

In previous versions, “Grid Column” was an option in the Dialog type dropdown, which
would make Extra Fields appear as standard edit columns in the Sales Order, Job and
Opportunity grids. This release adds the ability to have other types of Extra Field, e.g.
check boxes or dropdown lists as a grid column.

When configuring Extra Fields in the MYOB EXO Configurator, a new Grid Column
option has been added separately from the Dialog type dropdown, so that multiple
dialog types can be used as a grid column Extra Field:

/E MYOB EXO Configurater - Demo Mode = = £3
i File Account Help
i Peo | {2} Company ] Essential [g Admin |8 System |& Profiles [ Forms ) Staff %% Utilities

4 System g Mew | o Edit | [ Save 3¢ Cancel |f[j Delete | 4 F M | 5 AddField <Y Encryption

Display Names
4 EventLog Table: DR_ACCS Display: Mask

: - EventReason Classes
i EventReasons
- Extra Fields

Field: AUTOBILLCODE

Details | Eyents

Table name: [SMESDRD_LINES '] o =d
o

Field name: [

Display name:
Tooltip:

Data type:
Length:

Position {1-24):

I [ Grid Column I

Size:

Dialog type:

Loakup SQL
Key field:

Display field:

|tandard Edit

[T Mixed Case [ read Only

23.
24, Notused

ACCNO

NAME

Motopartz.co.nz |Demo

”E)(oadmin |

For header tables, the Grid Column option is always unticked and for line tables it is
always ticked. The only exception is the SALESORD_LINES table, where the option can
be changed—if it is ticked, Extra Fields will appear in the grid; if it is not, they will
appear in the line periscope.
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When the Grid Column option is ticked, the following options are available in the
Dialog type dropdown:

e Standard Edit

e Check Box

e Drop-Down Edit

e Drop-Down Selection

e Drop-Down SQL Selection
e Date Picker

Grid column Extra Fields support the Read Only option. This means it is possible, for
example, to create an Extra Field that cannot be edited when displayed in grids and is
only populated by an Extra Field event.

Extra Fields on the Sales Order Supply Grid

Any Extra Fields added to the SALESORD_LINES table will now appear on both the
Order Details grid and the Supply Details grid, provided the new Grid Column option is
ticked.

GL Codes on Debtor Invoices

This release adds the ability to enter GL codes on Debtor Invoices in the core EXO
Business module (but not EXO POS). When the new Enable GL code entry into the
stock code field on a debtors invoice User-level profile setting is enabled, GL codes
can be entered into the Stock Code column of the Invoice Entry window.

Note: This feature is enabled by default—if you want to restrict its use for some

users, disable the setting for those users’ profiles.

To enter a GL code, enter “@” followed by the code. You can also enter “@” by itself
or “@” and a partial GL code, then press ENTER to search for a GL code. Once entered,
lines containing GL codes are highlighted in green:

e Eny =)
i File Utilities Help [ ]
P Mew ||l Save X Cancel | xli] New Account | dﬁ Tax Rates | ] |
Account: CASH SALES Alert:
Invoice | Payments / Delivery!
Account: 0, CASH SALES Salesperson: GST Induded: [
Invoice date: 01.05.2013 E~ Customer order no: Age: 0. May 2013 w  (Campaign Wave:
Payment due: 01.05.2013 E~ Invoice no: NZD: 1 Opportunity:
Reference: Location: 1. Auckland - Branch: 0. AUCKLAND A
Stock Code Description Qty @Price Disc(%) [ Total Batch Code Options Analysis Codes Job Code
00-01000-00 SALES 1 0.00 0.0 0.00
AIRPREO1 AIR PRESSURE GAUGE 1 5.19 0.0 5.19
AIRSUSO01 AIR SUSPEMSION 1 248.10 0.0 248.10

This feature is compatible with the existing Enable display and override of GL code
from stock item profile setting, which displays a GL Code column on the Debtor
Invoice window. In this case, the GL code entered in the Stock Code column is also
displayed in the GL Code column.
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Note: To ensure backward compatibility with existing custom reports and add-
ons, the “@” stock code must exist as a placeholder for a valid stock code.
The DBUpdate process creates an “@” stockcode when updating the EXO

Business database to 8.7 if one does not already exist (it always exists by
default, but may have been removed). No other stock codes should contain
an @ symbol—this can be enforced by configuring the Prohibited
characters in stock codes Company-level profile setting.

The Invoice.clf, Emaillnvoice.clf and Viewlnvoice.clf forms have been updated with
new line-formatting logic to display GL code lines differently from Stock or Lookup
lines.

Note: To take full advantage of this feature, it may be useful to modify
customized invoice formats to format General Ledger code lines differently
from stock lines based on the new database field DR_INVLINES.CODETYPE
(GL Code lines have a CODETYPE of “G”).

Improvements to GL Posting

When right-clicking on the batch details displayed on the Post to GL Ledgers window,
the View Pre Posted Transactions right-click option is now a sub-menu with two
options: Selected Account or All Accounts:

‘GL Post Run Batch: 4 Description : GLPOSTRUN #8 for GL Period April 2013: CREDITOR
GL Period : April 2013

Creditors Ledger
10335000 L View GL Account H
01-04550-01

View Pre Posted Transactions Selected Account
01-05500-00  CREDITORS CONTROL All Accounts £191.50
01-05550-00  STOCK CLEARING $191.60

Stock Ledger

00-02150-00  ON COST VARIANCE
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The Selected Account option behaves the same as the View Pre Posted Transactions
option in previous versions, showing the pre-journals that will be posted for the
account that was right-clicked on. The All Accounts option displays a consolidated view
of all accounts in the grid:

|/ Pre-Posted GL Trans =lie =S
i File Help (i)
i 5 Print

GL account: All

Ledger GL Account Details Chyg no Inv no Debit  Credit Section GL Group B

01-05500-00 CREDITORS CONTROL Creditor Inv - 1 AUCKLANDPAR | (123 | | $19160/8/5 |CurrentLizbiliies

Creditars 01-05550-00 STOCK CLEARING AIR PRESSURE GAUGE INVLINE- | 123 $43.00 B/S  Current Liabiities

Creditors 01-04550-00 G5T PAID AIR PRESSURE GAUGE INVLINE- | 123 $0.00 B/S | Current Liabiities

Creditors 01-05550-00 STOCK CLEARING ANTISEIZE LUBRICATOR -INVLINE- 123 5£148.60 BfS Current Liabilities

Creditors 01-04550-00 GST PAID ANTISEIZE LUBRICATOR -INVLINE- 123 £0.00 BfS Current Lizbilities

Creditors 01-03350-00 FOREIGN EXCHAMNGE VARIANCE AIR PRESSURE GAUGE -STKCOSTV... £0.00 PL Overhead Costs

Creditors 01-05550-00 STOCK CLEARING AIR. PRESSURE GAUGE STKCOSTV... $0.00 Bfs | Current Liabiities

Creditors 01-02050-04 ACCESSORIES AIR PRESSURE GAUGE STKCOSTY... 50.00 P Costofsales

Creditars 01-03350-00 FORELGN EXCHANGE VARIANCE ANTISEIZE LUBRICATOR STKCOSTV... $0.00 P |Overhead Costs

Creditors 01-05550-00 STOCK CLEARING ANTISEIZE LUBRICATOR STKCOSTV... $0.00 B/S | Current Liabiities
Creditors 01-02050-04 ACCESSORIES ANTISEIZE LUBRICATOR -STKCOSTV... 40,00 PL Cost of Sales

Stock 01-04200-00 STOCK ON HAND AIRPREOI: Stk Recpt #1 RECEIPT 10054 £43.00 BfS Current Assets

Stock 01-05550-00 STOCK CLEARING Stk Recpt #1-AIRPRED1 RECEIPT 10054 $43.00 B/S Current Lizbilities

Stock 01-04200-00 STOCK ON HAND ANTSEIDL: 5tk Recpt #1 RECEIPT | 10054 514860 BfS  Current Assets

stock 01-05550-00 STOCK CLEARING St Recpt #L-ANTSEINL RECEIPT | 10054 $148.60 B/5  Current Liabiities

Stock 00-02150-00 ON COST VARIANCE Stk Reecpt #1LVARIANCE RECEIPT | VARIANCE $0.00 PL |CostofSals

$8320  $M3W i
<[ 3

Total Amount:  0.00 Total Transactions: 16

Mnﬂﬂ.mm

In both cases, the Pre-Posted GL Transactions window now displays additional
columns, showing more information about the batch.

Business Alerts

This release adds the ability to set up custom business rules and alerts that are
triggered when one of the following transactions is saved:

e Sales Order e Opportunity Quote

e Purchase Order e Job Quote

e Creditor Invoice e Job Transaction

e Debtor Invoice e Direct Material Entry

e Direct Time Entry

Note: Alerts on Debtor and Creditor Invoices are only triggered from Invoice
Entry screens, e.g. the Creditor Invoice Entry screen or the Invoice Entry
screen in EXO Job Costing. They are not triggered when creating the invoice

from another screen, e.g. when creating a Debtor Invoice from a Sales
Order. Similarly, creating an Opportunity by copying an existing one will
not trigger alerts on Opportunities.

Rules using custom conditions can be attached to each of these system events; when a
rule’s conditions are met, a message can be displayed to the user and a notification
email can optionally be sent to one or more addresses.
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Business Alerts are set up in the EXO Business Configurator at System > Event Log >

Business Alerts:

= MYOR EXO Cenfigurator - Demo Mode = =1 23
! File Account Help
: E}. | #2% Company *J] Essential [ Admin |3 System SLJ Profiles [=5] Forms ﬁ) Staff i Utilities
4 System 1) New | Save |7 Save & Exit 3¢ Cancel [#fEdit [fJ Delete @yPrint | 4 b b
i~ Display Mames
4 EventLog Rules for Event: Szve Sales Order Show All
Event Reason Classes
Event Reasons Rules | Detalls
Business Alerts
4 Email Service Order ID Event Rule Active Behaviour
i Emai Service Confiqurats -- Check fofal dscount —-m;-
*- Email Time Configuration 2 Save Sales Order ‘You are charging freight on a freight |SQL Query Warning
‘. Extra Fields 3 3|Save Sales Order Discount on order is too high (Sample Record Conditon [N Warning
1 4 Save Job Costing Transact Job has outstanding purchase order | SQL Query M EBlocking
1 5 Save Purchase Order Stop Purchase orders against locked ;SQL Query M Blocking
Motopartz.co.nz |Demo ”F_madmm |

The Rules tab displays all rules defined in the system for the selected event;
alternatively you can tick the Show all box to display all rules for all events. A selection

of example alerts is installed with the system.

Rules are listed in order of priority, i.e. in the order that they will be applied. To change
priorities, move rules up or down using the up and down arrow buttons.

Double-click on a rule to edit it or click New to create a new rule for the selected event
(the New button is disabled when the Show All box is ticked). When adding or editing
a rule, the Details tab appears. The Options sub-tab displays the conditions that must

be met for the rule to be activated.
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= MYOB EXO Configurator - Demo Mode o =B EE
! File Account Help
i fta | (3} Company <] Essential [ Admin ,m‘gd Profiles [=5] Forms i Staff i+ Utilities
4 5}"5‘]_2’“ xi] New L'E‘ Save ﬂ Save & Exit Xganr_el [ Delete -,‘E:JErint | H 4 F H
i~ Display Mames

4 EventLog Rules for Event: [Save Sales Order V] [~ show all
Event Reason Classes

Event Reasons Rules | Details

Business Alerts

4 Email Service Name:  Chedk total discount [¥] Active
¢ L Email Service Configuratii —|—I—|
: Options | Acti to Staff
Email Time Configuration ctions | Apply
i Extra Fields Run Against: Rule Type:
@ Line Datasets _) Header Datasets

Behaviour:

Message:

0 Silent The total discount on this Sales Order is @TOTALDISC % - this exceeds the limit of 20%.

'@ Warning

~) Blocking

Event Filter:

@TOTALDISC > 20

4 n 3

Motopartz.co.nz Demo ExoAdmin

The Run Against option determine whether the rule should be applied to all lines
related to the record, or to the record header.

The Rule Type option determines how the rule’s conditions (see page 22) will be
applied. Choose from:

e Record Condition — applies conditions against the record.
e SQL Query — applies a SQL query to each line individually.

Once the rule is saved, this property cannot be changed.

The Behaviour section specifies what should happen in the EXO Business interface
when the rule is triggered:

e Silent — no message is displayed to the user, although the fact that the rule was
triggered is still logged (see “Business Alert Auditing” on page 26).

e Warning —a warning message is displayed to the user with Yes and No options.
The user can click Yes to proceed with the action or No to cancel.

e Blocking —a message is displayed to the user indicating that the action cannot
proceed.

For “Warning” or “Blocking” rules, enter the message to display to the user in the

section below. This message can contain the same parameters that are used to build
rule conditions—see below.
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Rule Conditions

The bottom section of the Details tab is where you enter the conditions that must be
met to trigger the rule.

Rules with the type “Record Condition” are entered in the form of a filter that can
include the parameters detailed below.

Rules with the type “SQL Query” are entered in the form of a SQL statement to run
against the EXO Business database. The parameters below can also be used in SQL
statements.

Parameter Meaning

General (available for all rules)

@CURRENT_USER

The ID number of the logged on user.

@STAFFNAME The name of the logged on user.

@NOW The current date and time.

@TODAY The current date.

@EXOLINK A formatted exo:// protocol hyperlink to the transaction, e.g.

exo://saleorder(10001). Can be used in notification emails.

Sales Orders

@ACCNO The ID number of the Debtor account on the Sales Order.
@ACCOUNTNAME The name of the Debtor account on the Sales Order.

@ORDERNO The ID number of the Sales Order.

@SALESNO The ID number of the salesperson on the Sales Order.

@SUBTOTAL The Sub Total amount on the Sales Order.

@TAXTOTAL The GST Total amount on the Sales Order.

@TOTALDISC The total discount on the Sales Order.

@UNDISCOUNTED The undiscounted total of the Sales Order.

@H A specified field from the SALESORD_HDR table, e.g. @H.DUEDATE.
@L A specified field from the SALESORD_LINES table, e.g. @L.STOCKCODE.

Purchase Orders

@PURCHORDNO

The ID number of the Purchase Order.

@ACCNO

The ID number of the Creditor account on the Sales Order.

@ACCOUNTNAME

The name of the Creditor account on the Sales Order.
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Parameter Meaning

@SALESPERSON The ID number of the staff member in the Purchase Order’s Ordered by
field.

@H A specified field from the PURCHORD_HDR table, e.g. @H.ORDERDATE.

@L A specified field from the PURCHORD_LINES table, e.g. @L.UNITPRICE.

Creditor Invoices

@SEQNO The ID number of the invoice.

@ACCNO The ID number of the Creditor account on the invoice.

@ACCOUNTNAME The name of the Creditor account on the invoice.

@H A specified field from the CR_TRANS table, e.g. @H.TRANSDATE.

@L A specified field from the CR_INVLINES table, e.g. @L.TAXRATE.

Debtor Invoices

@SEQNO The ID number of the invoice.

@ACCNO The ID number of the Debtor account on the invoice.

@ACCOUNTNAME The name of the Debtor account on the invoice.

@H A specified field from the DR_TRANS table, e.g. @H.SUBTOTAL.
@L A specified field from the DR_INVLINES table, e.g. @L.DISCOUNT.
Jobs

@ACCNO The ID number of the Debtor account on the job.

@ACCOUNTNAME The name of the Debtor account on the job.

@JOBNO The job number.

@H A specified field from the JOBCOST_HDR table, e.g. @H.STATUS.

@F A specified field from the JOBCOST_FLAGS table, e.g. @F.ISACTIVE.

@Q A specified field from the JOBCOST_LINES table, e.g. @Q.STOCKCODE.
@T A specified field from the JOB_TRANSACTIONS table, e.g. @ T.QUANTITY.

Opportunities

@ACCNO The ID number of the company account on the opportunity.

@ACCOUNTNAME The name of the company account on the opportunity.

@OPPORTUNITYID The ID number of the opportunity, or “New” if it has not been saved yet.
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Parameter Meaning

@CONTACTID The ID number of the contact associated with the opportunity.

@CONTACTNAME The name of the contact associated with the opportunity.

@H A specified field from the OPPORTUNITY table, e.g. @H.PROBABILITY.
@L A specified field from the OPPORTUNITY_QUOTE table, e.g.
@L.QUANTITY.

The alias parameters that give access to the fields of a table (@H, L@, etc.) can be used
to access Extra Fields; however, computed fields are not supported in Business Alerts.

Note: While these parameters are not case-sensitive, the values of table fields

are, e.g. @F.ISACTIVE would need to look for the value “Y”, not “y”.

Rule Actions

The Actions sub-tab defines a list of actions to perform when the rule is triggered. At
present, the only available action is to send an email to specified recipients using the
new EXO Email Service (see page 27).

E_ MYOB EXO Cenfigurator - Demo Mode = =] £2
 File Account Help
T::.. | {2} Company ~':_2] Essential Adrin il Systern a\j Profiles  =5] Forms ﬁ Staff ke Utilities

4 System Ty New [ Save [ Sswe & Exit 3¢ Cancel [f] Delete @aPrint | 4 b b
i Display Names
4 Eventlog Rules for Event: [Sa\re Sales Order V] [~ shaw All
:  ~EventReason Classes
:  ~EventReasons Rules | Detais
i - Business Alerts .
4 Email Service Mame:  Check total discount Active
i ~Email Service Configuratii "
i Actions
¢ -Email Time Configuration ‘ Options | |-QDD|¥ fo SiaFFl
-Extra Fields 7 New [ Edit [, Save Action ¢ Cancel fffDelete | [{ 4 b K
Actions | Details |
D Action Type
Flenail spervisor _____________lEmail |
— . =
__—--"‘—-'-_._.{ e L

All actions set up for the rule are displayed in the order that they will be applied.
Actions can be re-ordered using the arrow buttons on the right. Click New to create a
new action.
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[} MYOB EXO Configurator - Demo Mode

4 System
Display Mames
4 Eventlog
-Event Reason Classes
-Event Reasons |R.ules | Detals ‘

- Business Alerts

Chedk total discount

4 Email Service
.~ Email Service Configurati
¢ Email Time Configuration

| options | Actions | Apply to Staff

i Extra Fields

Mame: Email supervisor

Internal Recipients: [Nene selected

Other Recipients:

Subject: Discount exceeded on Sales Order

Email Type: @ Plain Text  (7) HTML

@CURRENTUSER has attempted to apply a discount greater than the 20% limit to @EXOLINK.

This is an automatically generated email.

On the Details sub-tab, enter a descriptive name for the action, then specify who to

send the email to. One or more EXO Business staff members can be selected as
recipients from the Internal Recipients dropdown, and other email addresses can be
entered manually into the Other Recipients field.

Enter a subject line and the message text to send/display. The message body can

include any of the parameters that are available for the rule (see page 22). In

particular, the @EXOLINK parameter can be used to insert a formatted exo:// protocol

hyperlink to the relevant record into the email.

Once all information has been entered, click Save Action to add the action to the rule.

Note: Clicking Save Action adds the action to the rule, but does not save the rule
itself—click the Save button on the main toolbar to save the rule and all of

its actions to the EXO Business database. Rules that have been added but
not yet saved are listed on the Actions sub-tab with the ID “New”.
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Applying Rules to Users

The Apply to Staff sub-tab lets you specify which EXO Business staff members the rule

applies to:
= MYOB EXO Configurator - Demo Mode o B
! File Account Help
i te. | {3} Company -] Essential [g Admin |3 System |8 Profiles 5| Farms ﬁ Staff ik Utilities
4 System 43 New Save Save & Exit Cancel Delete Erint M 4 k H
- Display Mames LA s A s X< m — @ — | )
4 EventLog Rules for Event: [Save Sales Order V] [] Show Al
- Event Reason Classes
~Event Reasons Rules | Details
-(Business Al Name: | Check total discount 7] Acti
4 Email Service - scoun Active

- Email Service Configurati
Apply to Staff
- Email Time Configuration PRl

--Extra Fields

DAVID CRANSTON

[ pEmMo

[C] EXO BUSINESS ADMIN ACCOUNT
[] GREG MANNING

[F] INTERNET SALES

[ MALCOLM BREEN

[] svsoEA

[ oM MCINTOSH

Tick the boxes for the users that this rule applies to, or tick Apply To All Users.

Business Alert Auditing

Every time a Business Alert is triggered, an entry is recorded in the REASON_EVENTS
table. New Reason Classes are created automatically for each type of event that alerts

can be created for.

For alerts that send a message, an entry is also stored in the new EVENTS_SCHEDULE

table. Entries include the values of all parameters relating to the rule.

The Audit Report (ReasonReportbyClass.CLR) has been updated to include information

on Business Alerts.
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EXO API

This version includes new configuration options to support the EXO API. The local
components needed to access the EXO API from an EXO Business server can be
installed and set up using the MYOB EXO Business Services Setup Wizard and the
MYOB EXO Business Service Configuration utility (see “Error! Reference source not
ound.” on page Error! Bookmark not defined.).

A new “EXO API” module can be added in the Company section of EXO Business Config;
when this module is added and licensed, a new API Access tab appears when editing
staff members:

E MYOB EXO Configurator - Demo Mode = = E3
! File Account Help
i fe. | (3} Company <] Essential [ Admin 8 System &4 Profiles =] Forms | Staff 4% Utilities
4 Staff | New |J Edit | lﬂ Save X Lancel | H 4 F H
4 Menus
i iDropdown Menu StaffNo: 1 Name: ERIDGET FAIRWEATHER
siness Flow Menu

Details | Authority | Sales Team | AP Access

lenu Definition
i bSetup Widgets
4 Profile Assignment
L Staff
-~ Computer ey I0eXAICIIKY 1QILCIhbGAOITIUZT INiJ9. ey JleHAICIEZNZk SNTE 2NjksImlzeyI6IMEMS0 1L TIxL TMSNDgzMDY SNDUBMTU2O0TLxN] Y 4y 00MIQ2Mic
i Security Profiles

Allow API Access

Ticking the Allow API Access box generates an APl token for the staff member. You can
right-click on the token to copy it to the clipboard.

See the MYOB EXO API Release Notes document for more information on the EXO API.

EXO Email Service

This release adds an email service utility, ExoEmailService.exe, which can be used to
automate the sending of emails from the EXO Business system. This service is used by
the new Business Alerts (see page 19), but it can potentially be used to send emails for
any reason.

Installing the Service

You can install and set up the EXO Email Service using the MYOB EXO Business Services
Setup Wizard and the MYOB EXO Business Service Configuration utility (see “Error!
eference source not found.” on page Error! Bookmark not defined.).

Run the MYOB EXO Business Services Setup Wizard, and when asked which features
you want to install, make sure that the Messaging Service option is enabled.

Once the wizard has completed, you are given the option of running the service
configuration utility to set up the service. You can run the utility,
MYOB.ED.EXO.Cloud.ServiceConfig.exe, at any time after installation.

Note: The service configuration utility must be run on the server that the EXO

Email Service is installed on, using an account with administrator privileges.
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The email service can also be set up manually:

1. Copy the ExoEmailService.exe file to the main EXO Business install directory.

2. Open a command prompt with administrative rights at this location.

3. Enter ExoEmailService.exe /install [connection], where
[connection] is the connection name for the instance of EXO Business that
you are installing the service for.

You can install the service for multiple instances of EXO Business by specifying multiple
connection names, separated by spaces, e.g.

ExoEmailService.exe /install Connectionl Connection?2

Once the service is installed, you can update the list of instances that it is installed for
by entering:

ExoEmailService.exe /config [list of connections]
This removes all current connections and adds only those connections you specify, i.e.

if you want to add a connection, you must list the new connection and all existing
ones.

Note: The EXO email service runs using the Local System account. This means
that the EXO Business database connection must have been created while
logged in as an administrator account; otherwise the service will not be

able to find the connection details. If you receive the error “Failed to start
service”, you may need to open the EXO Business Connection Editor
window while logged in as an administrator, then delete and re-create the
connection.
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Configuring the Service

Once the service has been installed, you can configure it in the EXO Business
Configurator at System > Email Service. Two configuration screens are available. The
first, Email Service Configuration, lets you configure the details of the email server,
including address, authentication and default user information:

ﬁ MYOR EXO Configurator - Demo Mode = =1 23
! File Account Help
i fra | ¢34 Company ] Essential Admin |14 System Profiles Forms € Staff <& Utilities
— =
4 S:ysbem H Save Cancel
i Display Names
4 EventLog SMTP Configuration
Event Reason Classes )
Connection Info
Event Reasons B
Business Alerts Server Address: Service: EXOMSGSVC
4 Email Service __ State: Running
Email Service Configurati S e 0 Service Control
Erna.il Time Configuration [ Requires Authentication
Extra Fielcs Server User ID : Start Service | | Stop Service
Password : |
[] show character
[Fluse s
[ use 551
User Info
“From” Name
"From"” Address
Reply Address
BCC Address
File Directory
4 LU +
Motopartz.co.nz Dema ||E)mAdnm
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The second configuration screen, Email Time Configuration, lets you specify when the
email service should and shouldn’t send emails, and the how often it should check for
new emails to send:

= MYOR EXO Cenfigurator - Demo Mode o B E
File

4 System ) New | Save 3¢ Cancel [ Delet=

i~ Display Mames

4 EventLog ‘Workflow Event Email Blackout Times and Interval
i i-EventReason Classes
Event Reasons
Business Alerts
4 Email Service Start time End time sunday Check for new emails every 120 % seconds
Email Service Configurati
*.| Email Time: Configuration
i Extra Fields

Don't send emails between: Don't send emails on: Frequency:

Monday

[ Tuesday
Wednesday
[P Thursday

Friday

—
Note: Uses 24 hour time format TG,

Service Status:
Service Control

Service: EXOMSGSVC

State: Running Start Service | | Stop Service

4 it ]

Motopartz.co.nz Demo | [ExoAdmin

Both configuration screens have controls that let you stop and start the email service.

Once the EXO Email Service is running, it scans the EVENT_EMAILS table for unsent
email messages, and attempts to send all messages that it finds. If an email fails to
send, the service will attempt to send it again the next time it checks for emails.

Note: More detailed information on installing, configuring and using the EXO

Email Service are available in the EXO Email Service white paper, available
on the new EXO Business Education Centre (see page 31).
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EXO Education Centre

The release introduces the EXO Business Education Centre, a website that provides a
central point of access to all EXO Business documentation. This includes:

e EXO Business Help files and User Guides

e Release Notes for the current and previous releases

e EXO Business White Papers

e A growing library of instructional videos

e Database schemas for selected areas of the EXO Business system

A search function is available, which searches all available documentation for the
search terms entered. Search results can be filtered to show only one type of
documentation, e.g. only Help pages or only Release Notes.

The Education Centre can also be accessed in any web browser at
http://help.myob.com.au/exo. The new Education Centre option in the Help menu
opens the Education Centre in your default web browser.

This release adds a new Education Centre widget, which displays the Education Centre
on any dashboard interface. The EXO Business demonstration databases (EXO_DEMO
and EXO_LIVE) include a new Education Centre tab on the default business flow menu:

E| :y. @ ﬁ .3 | MYOB EXO Business - Demo Mode = = 52

I File Account Transactions Reports  Utilities  Setup | Help

@ Online Help

=y . EX0 Business on the Web i
| \ T d Conditi e
[ | Terms and Conditions n/

Education Centre

Task Scheduler Sales Purchases Stock About Reports Utilitie:s Education Centre
Layouts: Education Centre - ld e H|+ @3-
Education Centre v X

tp:/fhelp. myob. com. u/exo,

MYOB EXO Business Education Centre

Access online help and resources for MYOB's enterprise business management system

| »

Search the Education Centre

m

Help Files Videos
You can view the online Help files for the EXO Business system_ Select the Watch short instructional videos that show you how fo set up and use the
version of the Help files you would like to view: EXO Business system
Selectaversion v (| View The Education Centre
Duration: 1m:41s
Release Notes Watch this quick oy

available in the
PDF Release Notes are available for current and previous versions of EXO Education Centre

Business. Select the Release Notes document you would like to read:

Salact a varsion View View all videos >> <



http://help.myob.com.au/exo

EXO Business 8.7

Online Help

The Education Centre includes new EXO Business Help files, which are now available
online as a set of web pages that can be viewed in any web browser. EXO Business will
open the online Help in your default web browser when F1 is pressed or when Online
Help is selected from the Help menu.

The existing CHM Help files are still available for offline use. The help file that EXO
Business will access is determined by the existing Location of help files Computer-level
profile setting. If the location specified in this setting starts with http:// or https://,
EXO Business will look for online Help pages at the specified URL. If the location does
not start with either of these strings, EXO Business will look for a CHM Help file at the
specified location.

Note: In an upgrade to EXO Business 8.7, the Location of help files setting is

updated to the URL of the online Help pages by default.

Widget Enhancements

This release includes changes that make it easier to set up widgets and assign them to
users. When creating or adding widgets, the Module Visibility dropdown now allows
you select multiple modules:
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A new Menu Assignments dropdown lets you assign the widget to one or more menus

immediately:
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When adding widgets to staff members’ menus manually, a new Widgets section
appears at the bottom of the menu. All widgets added to the menu appear in this
section now, making it easier to see which widgets have been added to each menu. In
an upgrade to EXO Business 8.7, all widgets that are currently on menus are moved
into this section automatically.
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The Setup Widgets screen is now available from the Staff > Menus section of EXO
Business Config as well as the Admin > Dashboards section.

Loading Widgets

The system has been updated so that dashboard widgets are not loaded until they are
actually displayed. This means that on an interface that contains many different
dashboards, e.g. the default business flow menus for some modules, the interface will
be faster to start up, as the system no longer loads all widgets on startup, just those
that are displayed initially.

Support for Windows Aero

It is now possible to enable support for the Windows Aero interface, including the Aero
Flip and Peek features. To enable Aero features, run EXO Business executables with the
/AERO flag.

Note: This feature is currently still experimental, and may result in application

windows behaving unexpectedly.
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Resolved Issues

EXO Business Core

Service Request ID Description

12225369598 When a large volume of records (greater than 10,000) existed in the

12534777221 PREVIOUS_ITEMS table, the error message “Record not found or changed by
12330711451 another user” could appear and the Recent Items widget would take a long time to
12335935639 load. These issues have been resolved; the PREVIOUS_ITEMS table is now cleaned
12330710671 out every time a module containing the Recent Items widget opens, so that there
12288245428 can be no more than 100 items in the Previous Days section, and no more than 50
12258822196 items in the Today section.

12258822191

12257514511

12203693726

12190564240

11520852631 When the profile setting Allow manual entry/override of discounts on debtor
12669390091 invoice and sales order lines was disabled, discounts were automatically removed
12380261751 from Sales Order lines. This has been resolved. When this setting is disabled, the
11517609781 Discount column becomes read-only; any discounts that apply to each line are not
11050594604 removed, and cannot be manually edited.

11264696622 After running the CSV Import wizard in the Utilities section of EXO Business Config,
12240013331 the confirmation/error message indicating whether or not the import was
11262280731 successful did not appear. This has been resolved.

11133474541

12710887119 The Total Stk Qty and Loc Qty columns on the Transactions tab of the Stock Item
12675954051 Details window did not update after a stock transfer. This has been resolved.
11749626982 The maximum attachment size of batch invoice mailshots can now be set by the
12266358381 Batch Invoice Mailshot Attachment Size Limit Computer-level profile setting.
12140668151

11808078581

11674594226

11325750512

11325736979

11325562782

11325562769

12119946463 The output item of a Bill of Materials cannot be a lookup item; however, if an item
12108433341 wasn’t specified, it would default to the DEF BOM OUTPUT item, which was a
11518862466 lookup item. This no longer occurs, and Bills of Materials cannot be saved unless the
11518258309 output item is a valid stockcode.

11878121991 It was not possible to copy the delivery address from a fully processed Sales Order.
12490212311 This has been resolved.

11876509880

The Loc and To loc columns on the Transactions tab of the Stock Item Details
window were blank if the stock levels in the relevant locations were zero. This has
been resolved.
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Service Request ID Description

The errors “Catastrophic failure” or “Database connection terminated” could occur
when running an invoice mailshot on Windows XP. This has been resolved.

EXO Job Costing

Service Request ID Description

11211409487 Foreign currency Debtor accounts can be used in EXO Job Costing when the Allow

11242763874 foreign currency debtors in Job Costing profile setting is enabled—see page 12.

11242763871

11243689671

11209601321

11904033522 The exchange rates stored in the JOBCOST_HDR, JOBCOST_LINES and

11893574862 JOBCOST_TRANSACTIONS were limited to two decimal places. This has been
resolved; there is no longer a limit on the number of decimal places.

12456243029 Proforma invoices (Progress Billing) now display detail at the line level, instead of

11299059921 containing only a single line—see page 13 for more information.

11933973297 The Convert Quote to Invoice (No Stock Movement) right-click option on the

12151994441 Quote grid is now hidden if Progress Billing is not available or if the Job Cost Billing

11914519751 Mode profile setting does not contain “P”.

11861683041

11303441646 When moving a lookup item from one job to another, some of the required stock

12033811491 transactions were not generated, if the item was originally receipted onto the job

11317808907 via a Creditor Invoice. This has been resolved.

11297333301

11290984409

11277532431

11242763376

11072642086 “Invalid floating point operation” error messages appeared when creating assets

11071738179 from output items, if the sum of the latest costs added to zero. This has been
resolved.

11181505006 This release adds a Send All to Invoice button to the Timesheets tab of the Job

11178980391 Details window—see page 13.

11825062615 This release adds improvements to the job invoicing process, including the ability to

11869133431 view sub job lines when invoicing a master job—see page 9.

11819161371

11818882638

11858591170 It was not possible to assign sub job lines or allocate sub job costs to a Billing

11830853102 Schedule raised in the master job. This has been resolved.

11690197932

11862086701

11679364921
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Service Request ID Description

12281250008 Saving a job without populating the Cust O/N field on the header resulted in a
12269530681 single space being inserted into the CUSTORDNO field. This has been resolved; if the
Cust O/N field is left blank, the CUSTORDNO field remains null.

11508049699 Using the Marked Lines > Set Markup % right-click option on kit lines generated the

11508049716 error message “QuoteQuery: Dataset not in edit or insert mode.” This has been

11508049679 resolved.

12414135276 Job retentions were incorrectly rounded for large values. This has been resolved.

11518112484 Also, the display of decimal places on job retention rates was rounded according to

11517448482 the EXO Config setting on discount decimal places, which should have no bearing on
it. This has been resolved; the % Rate field on the Job Retention Levels window now
displays however many significant decimal places are entered, up to a maximum of
three.

12528452385 It was possible to edit the Sell Price of an invoiced job transaction. This has been

12518087951 resolved; the Cost Price and Sell Price of lines on the Cost or Timesheet tabs with a
status of W, |, X cannot be edited.

11649454401 When job quote lines were sent directly to the Invoice tab set, these lines would not

11649255801 be included in job cost totals. This has been resolved; when sent directly to invoice,
job quote lines’ TRANSTYPE property is now set to “C” instead of “Q”. In an upgrade
to EXO Business 8.7, all job transactions with the TRANSTYPE “Q” are updated to
“c”.

11166944048 This release includes fixes and enhancements to the Job Cost